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Lesson 2 Simple Animation 
 
Animating can be done in several ways, whether you’re using Flash or old-fashioned 
acetate cels. In all cases, something moves on the screen. For the approach taken in this 
lesson, you’re not expected to have any artistic skill or talent. You will create two basic 
shapes and make them travel across the screen, independently of each other. This will 
involve all the fundamental elements of animation in Flash: symbols, the Timeline, 
frames, keyframes, layers, and tweening. 
 
If you have ever made an animated GIF for the Web, you may have used frame-by-frame 
animation, which requires the creator to deliberately change the contents of each frame. 
A frame represents an instant in time. In Flash, you can change the duration of that 
instant. In Lesson 1, you learned how to change the frame rate: You can specify how 
many frames per second a Flash movie has.  
 
For the sake of comparison, motion picture film plays at 24 frames per second, a frame 
rate that produces a pretty good illusion of reality. It was too much work to draw 24 
separate frames for each section of an animated cartoon (back when the animators really 
had to draw them), so cartoons often repeated identical frames twice, or even three 
times. The film still ran at 24 fps, but in reality there were only 8 or 12 unique frames in 
each second. Those were duplicated to produce 24. 
 
Don’t worry about drawing individual frames, though—with Flash, you will draw 
something one time and use it over and over again. 
 
Rarely is there a need to create an animation sequence frame-by-frame in Flash. That’s 
where tweening comes in. Flash can move your object from Point A to Point B if you will 
just indicate where those two points lie on the Stage (or off the Stage, if you want the 
object to move out of sight). That part may surprise you with how easy it is—but first, you 
need to complete some preparatory steps. 
 

Lesson 2 
 
This lesson is divided into two parts. The first exercise deals with the creation of two 
objects and their conversion to graphic symbols. (If the objects have not been converted, 
they will not animate.) It also introduces the Library. The second exercise deals with 
animating the two symbols. 
 

Exercise 2.1: Creating Graphic Symbols 
 
1. Open Flash and make sure you can see the Stage and also the Tools, Timeline, and 

Properties panels, described in Lesson 1. If the Stage area is empty and there’s no 
Timeline (nothing there but gray), open the File menu and select “New.” If the Stage 
area is filled with a menu that includes the option “Create New,” select “Flash 
Document” there. 
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2. In the Properties panel, select the size (in pixels) of your Flash movie. Select a 

background color. Select a frame rate (some additional details about frame rates 
appear at the end of this lesson). Keep the frame rate at 12 fps for this lesson. (These 
choices were explained in Lesson 1, Step 2.) 

 
3. Use the drawing tools to create two separate objects. If you really hate to draw, make 

one rectangle and one oval, then move on to Step 4. If you’re feeling creative, try to 
make one object that fits inside another. If you want to draw but you can’t think of 
two good objects, try to draw these: an olive and a martini glass. 

 
Insert Figure 2.01 
Caption: Shapes drawn in Flash: You can draw an olive and a martini glass in Flash even 
if you are no good at drawing. First, make two separate ovals for the olive, and then 
select and drag the smaller one into position. Use the Line tool to make the glass. Select 
“Snap to Objects” from the View menu to make it easy to connect the lines neatly. 
 
4. File menu > Save As. Name your file and save it. The file extension for your working 

Flash file (.fla) will be appended automatically. Like all filenames on the Web, the 
name you give to a Flash file should have only lowercase letters, no punctuation, and 
no spaces. 

 
Note: On many Windows computers, the file extension has been hidden from you. If you 
would like to see file extensions when you view files, you can. In any window that 
displays folders and files, open the (Windows) Tools menu and select “Folder Options.” 
Click the View tab in the Folder Options dialog. Beneath the top folder there (“Files and 
Folders”), find the line “Hide extensions for known file types” and remove the check 
mark on that line. Click the Apply to All Folders button. Click OK to close the dialog. 
 
5. Now you will make each one of these shapes into reusable symbols. Select one of your 

shapes first.  
 

 Make sure you select the entire shape. Check that every part of the shape appears 
dotted, showing that it has been selected. You can use the (black) 
Arrow/Selection tool to select your shape (click and drag a selection box 
around the entire shape). 

 Do not select both shapes at the same time, or you would get one symbol instead 
of two. 

 
6. From the Insert menu/Flash MX, select “Convert to Symbol.” (In Flash MX 2004, it 

is on the Modify menu instead. You will quickly learn that pressing F8 does the same 
thing in either version, if your shape is selected.)  A dialog box opens. In that dialog 
box, select “Graphic” and name your new symbol something obvious (such as 
“olive”). Click OK. 

 
7. Follow the same procedure for your second shape. When a shape has been converted 

to a symbol, it will be surrounded by a “bounding box” (a thin blue line). If you don’t 
see the box, select the Arrow/Selection tool and click once on the symbol. 

 
Insert Figure 2.02 
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Caption: After you have converted a shape to a symbol, the new symbol belongs to the 
Library for this Flash movie. Symbols that are deleted from the Stage remain available in 
the Library. 
 
Warning: If you double-click a symbol, you will go into Symbol Editing Mode, which 
removes you from the normal Timeline. There’s no reason to get tangled up with that 
now, so if you can’t get the bounding box to appear, or you discover you can alter the 
shapes, press Ctrl-E (or Cmd-E/Mac) to return to normal editing and the main Timeline. 
Be very conscious of how you are clicking the objects on the Stage, because a single click 
and a double click have entirely different results. 
 
8. Now you’re about to see the glory of symbols in Flash. Open the Library panel 

(Window menu > Library, or press F11). If you named and converted your two 
symbols successfully, you will see them in the Library panel with the names you gave 
them. Grab one of them in the Library and drag it to the Stage. Do it several times.  

 
Note: This may seem like copying and pasting, but it’s different: Each instance of a 
symbol in Flash requires almost no storage space in the final Flash movie file. If you had 
separate copies of an image, each copy would carry its full “weight” and increase the file 
size accordingly. 
 
9. These multiples are called instances in Flash. Instances are not the same as copies, 

but they can be changed independently of one another. Select one of your symbols 
(click it once) and look at the Properties panel. You can experiment with alpha 
(transparency) for the selected symbol, or tint, or brightness (Figure 2.03). Changes 
you make to an instance in the Properties panel do not affect the symbol in the 
Library. 

 
Insert Figure 2.03 
Caption: Try out the effects you can apply to a symbol with the Color properties. Alpha is 
especially useful; use it to change the transparency of an instance. Brightness can be 
used to dim a button, for example. 
 
10. Another common thing to do to an instance of a symbol is to change its size. You can 

scale it (keeping the proportions the same) or skew it (making it look stretched or 
squashed). To achieve those effects, select the Free Transform tool, or open the 
Transform panel (Figure 2.04). You can also rotate the instance using either the 
tool or the panel (Figure 2.05). Open the Modify menu and check out the Transform 
options there too. 

 
Can you animate these effects? Of course you can! Just wait until you get to the 
second exercise in this lesson. (You’re almost there.) 

 
Insert Figure 2.04 
Caption: Several instances of the olive symbol were scaled with the Transform panel, or 
changed with the options available in the Properties panel. 
 
Insert Figure 2.05 
Caption: The Free Transform tool was used to rotate the glass. To rotate the olive, open 
the Modify menu, move to Transform, and select Rotate 90° CW. 
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11. Finally, delete everything from the frame (as explained in Lesson 1, Step 4). The 
Stage should be empty. If you have any doubt that your symbols are safe in the 
Library, you can grab each one and drag it out to the Stage just to make sure. 

 
12. File menu > Save. 
 
Note: Another great benefit to the way symbols work in Flash: As you delete frames and 
objects in the normal course of editing a Flash movie, all the symbols you created stay 
intact in the Library. (Libraries can also be imported to other Flash movies, so you can 
use your best symbols again and again.) 
 
Warning: Make sure you can see the bounding box (Step 7) before you delete a symbol 
on the Stage. If you do not see the box, you are inside the symbol, and you will 
permanently delete your shapes. If you clicked the symbol and you do not see the box, 
press Ctrl-E (or Cmd-E/Mac) to exit and return to normal editing. 
 

Exercise 2.2: Animating Two Symbols 
 
Now you’ll put those two graphic symbols to good use. Begin with an empty Stage, and 
check your frame rate. You need to know how many frames one second requires, so you 
can plan your animation. If your frame rate is 12 fps, you will need a sequence of 12 
frames to get 1 second of motion. 
 
1. Drag one symbol out onto the Stage. You must animate only one symbol at a time. 
 
2. So far, your movie has only one frame in the Timeline. Select a “future” frame in the 

Timeline. Since you know the frame rate, you can calculate how many frames you 
need to make your motion complete in 1 second. Go to the frame in the Timeline that 
is 12 frames (or whatever your movie’s frame rate is) to the right of Frame 1. Click 
that frame once. The frame will be shaded to show that it is selected. 

 
3. With that later frame (e.g., Frame 12) selected, press F6. This inserts a new 

keyframe. Inserting a keyframe is a crucial part of animation in Flash! Notice how all 
the frames from Frame 1 (the first black dot) up to the new keyframe (second black 
dot) have filled in with gray shading. Those frames are no longer empty! (Empty 
frames are always white.) Every frame in the long gray block contains exactly the 
same image. 

 
Note: On an iBook (and possibly some other laptops), the function keys (F keys) work as 
described here only if you press and hold Function (another key) while you press the F 
key. However, on most computers you can press the F key alone and get these results. 
 
Insert Figure 2.06 
Caption: Adding a keyframe at Frame 12 extends the Timeline. 
 
Note: The difference between a keyframe and all other frames is that a keyframe signals 
change. In a keyframe, something can be set as a beginning or an end in a sequence of 
change. The Flash designer cannot make a change in a frame that is not a keyframe. In 
the Timeline, a keyframe always has a dot inside it. A black dot shows that there is at 
least one object in the keyframe. A white dot shows that the keyframe is empty of objects. 
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4. To see motion between Frame 1 and Frame 12, you must change the position of the 

object. Right now, it’s in the same place in both keyframes in your Timeline. To 
make the object move in an animated sequence, you will put it into its starting 
position in the first keyframe, and into its ending position in the next keyframe. The 
keyframe containing the object is indicated by a black dot. 

 
First, select either keyframe (click once directly on the keyframe to select it). Then 
move the object on the Stage by selecting it (make sure you have the 
Arrow/Selection tool, and click only once to select the symbol) and dragging it. 
Do not double click! 

 
Insert Figure 2.07a 
Caption: Olive positioned above the Stage, Frame 1. 
 
Insert Figure 2.07b 
Caption: Olive positioned lower, on the Stage, Frame 12. If you want an olive to drop into 
the scene from a point offstage, position the olive above the main Stage area in the first 
keyframe, and then, in the next keyframe, position the olive where you want it to land. 
 
5. Add a motion tween: Click once on any frame inside in the long gray block between 

Frame 1 and Frame 12 in the Timeline. (These frames are not keyframes: They do 
not have a dot.) Then look in the Properties panel and find the menu labeled 
“Tween.” Change the menu choice from “None” to “Motion.” A solid line and an 
arrow pointing to the right appear inside the long block of frames, which is now pale 
blue instead of gray. 

 
Note: If you ever see a dotted line in the sequence, that means the tween did not work. 
The most common reasons: (a) Your object is not a symbol; (b) you have more than one 
object on the layer; (c) you do not have a keyframe at the end; (d) one of your two 
keyframes does not contain the symbol you are trying to move. 
 
6. File menu > Save. 
 
7. Test your animation (Method 1): Press Enter/Return. If nothing happens, press it 

again. 
 
8. Test your animation (Method 2): The playhead is a small red rectangle at the top of 

the Timeline, in the bar with the numerals. You can grab it and drag it left and 
right to test the motion in your movie; this is called “scrubbing.” It will not show you 
the real speed of the movie, but it can help you diagnose problems in the motion 
sequence. (You can also move the playhead to any frame and then press 
Enter/Return to play the movie from that point onward.) 

 
9. Make the motion longer and slower: Click once anywhere inside the motion tween 

block in the Timeline. Press F5 several times. Each time you press F5, you increase 
the motion sequence by one frame. (In other words, F5 adds frames. Regular frames, 
not keyframes. These are frames with no dot.) 

 
10. Make the motion shorter and faster: Click once anywhere inside the motion tween 

block in the Timeline. Press Shift-F5 several times. Each time you press Shift-F5, 
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you decrease the motion sequence by one frame. (In other words, Shift-F5 removes 
frames.) 

 
11. Move the starting point of a sequence: Click once on the first keyframe (the frame 

with a dot in it is the starting frame in a sequence) to select it. Release the mouse 
button (this is very necessary). Then click, hold, and drag to the right (or left) to 
change the starting frame’s position in time. Frames in the sequence will be removed 
(when you drag to the right) or added (when you move to the left) automatically as 
you do this. Try this, and test your animation (Steps 7 and 8) to learn how it works. 

 
12. Now it’s time to name the Timeline layer, because you’ll be adding a second layer in 

the next step. Here’s how to name (or rename) a layer: On the left side of the 
Timeline, you’ll see one layer (named Layer 1). Double-click the layer name and type 
to change it. To make the new name “stick,” click anywhere off the layer name, or 
press Enter/Return. Use a name that makes it easy to remember what’s in that layer. 

 
13. Create a new layer: Find the tiny icon (a page with a plus sign) on the left at the 

bottom of the Timeline, under the layer name(s). This icon pops up a label “Insert 
Layer” when you roll over it. Click that icon once to make a new layer. (The new layer 
will always be added above the selected layer. Layers can be moved up or down at 
any time by dragging them.)  

 
Insert Figure 2.08 
Caption: When you create a new layer in the Timeline, it is automatically the same length 
as the existing layer(s). A new layer always has one keyframe, at the beginning. Empty 
frames are always white. 
 
Note: It is essential that you place each object that will move in a separate layer by 
itself. If any other object is in the layer, the motion tween will not work. 
 
14. Name the new layer (see Step 12). 
 
15. File menu > Save. 
 
Note: The pencil icon (to the right of the layer name) indicates the active layer in the 
Timeline. When you draw or put something on the Stage, it will be on the layer marked 
by the pencil icon. Pay attention to which layer you’re on before you drag any new object 
to the Stage! 
 
16. Drag your other object from the Library to the Stage. Make certain it has landed in 

the second layer! Remember: Frames that are white are empty. When frames contain 
objects, they are a color other than white. 

 
17. Animate your second object by repeating Steps 2–5 on the new layer. 
 
18. File menu > Save. 
 
Insert Web site icon 
 
19. Test your movie: Ctrl-Enter (Win) or Cmd-Return (Mac). This is different from 

testing the animation by pressing Enter/Return alone, as you will see. 
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Note: When you test your movie by pressing Ctrl-Enter (Win) or Cmd-Return (Mac), 
you spawn a second window within the Flash application. If it is “maximized” (full size), 
it will hide your normal editing window. New Flash users sometimes close the whole 
application by accident when they try to close the testing window and return to the 
editing environment. Don’t make that mistake. 
 
Insert Figure 2.09 
Caption: The Timeline, with two layers. Each layer contains a motion tween. 
 
Insert Figure 2.10 
Caption: Three frames from a two-layer animation; the frames shown are 1, 4, and 12. 
Compare with Figure 2.09: You should soon be able to “read” a Timeline like this one 
and visualize what is in each keyframe. In Frame 12, the olive is behind the glass. An 
object in a lower layer in the Timeline is always “underneath” objects in higher layers. 
 
Note: When you test the movie by pressing Ctrl-Enter (Win) or Cmd-Return (Mac) for 
the first time, Flash generates a new file, with the file extension .swf—this is the file that 
will be played on the Web. Each time you test the movie again, this file is overwritten 
with the newest version. You’ll learn more about this in Lesson 3. 
 
20. You’ll notice that when you test the output Flash file, it loops, or repeats, forever. 

That is the default for Flash movies. To make the animation stop, you must use 
ActionScript. The standard way to handle ActionScript is to put it in a layer by itself; 
this makes it easy to find and edit your scripts. So, create a third layer now, and name 
it “actions” (without the quotes). 

 
21. Within that new layer, click the last frame in your movie (Frame 12) and insert a 

blank keyframe there (press F7 once). ActionScript always needs a keyframe. 
 
22. Open the Actions panel. (Find it on the Window menu if you don’t see it. In Flash 

MX 2004, it’s on the submenu “Development Panels.”) If you see the panel name but 
the panel is closed, then open the panel by clicking the small triangle widget to the 
left of the panel name. 

 
23. In the Actions panel, click in the list on the left side to open “Actions”; then click 

“Movie Control”; then double-click “stop”  (Figure 2.11). If nothing happens, check in 
the Timeline and make sure you have that blank keyframe selected. 

 
Flash MX 2004 Note:  
The Actions panel list in Flash MX 2004 has different sections. Instead of “Actions,” 
you’ll see “Global Functions.” Open that to find “Timeline Control.” Inside that section, 
you will see “stop” (Figure 2.12). Adding the script is the same: Just double-click “stop.” 
 
Insert Figure 2.11 
Caption: Actions panel, Flash MX. 
 
Insert Figure 2.12 
Caption: Actions panel, Flash MX 2004. Here’s what you should see in the Actions 
panel, depending whether you are using Flash MX (Figure 2.11) or Flash MX 2004 
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(Figure 2.12). In either case, you have now “written” an ActionScript command telling 
the movie to stop playing when the playhead reaches Frame 12. 
 
Note: You should see a tiny letter “a” (for “ActionScript”) on the last keyframe in your 
“actions” layer. The “a” indicates that ActionScript is written on that frame. 
 
24. File menu > Save. 
 
Insert Web site icon 
 
25. Test your movie: Ctrl-Enter (Win) or Cmd-Return (Mac). 
 

What should happen: The movie plays one time and stops. If it does not stop, you 
did not write the ActionScript, or you wrote it on the wrong frame, so go back to Step 
23 and try again. Don’t close the entire Flash application when you close the testing 
window! 

 

Tips About Animation 
 

Frame Rates 
 
How smooth, or how true to life, the motion in your Flash movie appears will depend on 
the frame rate you select. Flash sets a default frame rate of 12 fps, as you learned in 
Lesson 1. If you want the most realistic motion, you might select 24 fps, based on the 
frame rate of motion picture film. That could increase the size of your Flash file, of 
course—not the most desirable result. 
 
Macromedia recommends a frame rate of 15 to 18 fps for most Flash movies. However, 
some Flash developers have noticed that there can be significant differences in the actual 
playback frame rate on different operating systems. At least one developer recommends 
21 fps as a frame rate that will run comparably on both Windows and Mac systems. 
 
This will not matter much in cases where you have not created complex vector 
animations. If you use a high frame rate in a Flash movie where a lot of bitmaps (for 
example, photographs) are moving around, the frame rate may be forced down because 
of the higher demands a moving bitmap makes on the system. Gradient fills and alpha 
(transparency) also place a high demand on the user’s system when they are moving. The 
user’s computer might freeze up if your Flash movie demands too much processor 
activity. In other words, certain motion effects might not be speeded up by a higher 
frame rate. 
 
The bottom line: Test your movie on various computers and platforms. For your first 
animations in Flash, you can’t go wrong with a frame rate of 15 fps. 
 

Using Layers 
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Independent motion takes place on separate layers in Flash. (This is somewhat different 
from simple layer-based animations you may have learned to do in another program, 
such as Adobe ImageReady.) Put different animated objects into their own layers, alone. 
Then adjust each object’s movements individually. 
 
It helps a lot to name your layers intelligently, because it prevents mistakes. If you have 
placed all your non-moving background images on one layer, name that layer 
“background.” When you start working with text, you might find that you prefer to put all 
non-moving text fields on one layer. Fine! Name that layer “text blocks.” 
 
The longer you work with Flash, the more complex your movies will become. Practice 
good layer management now to make your work easier later. 
 

Masks and Motion Paths 
 
These two advanced techniques will allow you to achieve some effects that would be very 
time consuming to animate without them. 
 
A mask prevents selected areas from being seen. The oddest thing about a mask: You 
create a solid shape that represents the area you intend to be seen, and you position it 
over the area that will be visible. (This temporarily hides the area, but that will change.) 
The mask shape must be alone on a layer. That layer becomes a mask layer when you 
right-click  (Control-click/Mac) on it in the Timeline and select “Mask” from the pop-up 
menu. You can mask more than one layer beneath the same mask layer. You will learn to 
use a mask in Lesson 7. 
 
A motion guide layer allows you to draw a curved or straight line and then “attach” 
objects on lower layers (as many layers as you like) to make them move along the line. 
You can make a plane fly along a visible dotted line or a bird follow an erratic invisible 
trail. For detailed instructions and examples, search for “Tweening motion along a path” 
in the Flash Help files: Open the Help menu and select “Using Flash”—or just press F1. 
 

There and Not There 
 
Objects in the Library that are never used in your movie do not exist in the final exported 
Flash file (with the file extension .swf) and thus they do not add to the file size. That is 
not the case for objects you have dragged out of the Library. If you did not delete them, 
they are adding to the file size, even if they never show up on the Stage. Objects with an 
alpha of 0 are invisible, but they are still there—and so they add to the file size. 
 
This means you must remember to remove objects from the Stage when you’ve finished 
with them, or when you have decided not to use them. 
 

Simple Animation Summary 
 
For anyone who has not animated images before, the best approach is to keep it simple. 
Do not try to make human figures move naturally in your first week with Flash! Work 
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first with simple objects (instances of graphic symbols, in the language of Flash). Try to 
get them to move as you want them to. Experiment with transparency (alpha) and 
scaling. For example, you can use the Free Transform tool to make an object double size 
in Frame 1, half size in Frame 12, and then apply a motion tween. Does the object appear 
to shrink, or does it appear to move way from you? You can make an object fade to 
invisibility by starting at an alpha of 100 and ending with an alpha of 0. 
 
If you learn how animation in Flash works by moving rectangles and ovals around, later 
it will be less complicated for you to move blocks of text, photographs, and objects made 
up of separate, movable pieces. You might use the drawing tools to trace over a 
photograph of an object such as a passenger train, and then animate the individual cars 
of the train during a derailment. (All the cars could be instances of just one symbol.) 
Remember that each animated object must be alone in its own separate layer. (In Lesson 
6, you’ll learn how to contain multiple layers for one complex animated object in a single 
symbol called a movie clip.) 
 
By paying close attention to the Timeline, you will learn how to “read” it. Any confusion 
you have about frames and keyframes will decrease as you practice. Keep your eye on the 
dots (keyframes) and whether they are black or empty (white). Remember that a 
keyframe signifies a frame where a change begins or ends. Watch the frames and check 
whether they are gray, blue,  or empty (white). 
 

Conclusion 
 
In this lesson, you have learned to: 
 
1. Convert a shape to a graphic symbol. 
2. Open the Library panel and drag symbols from it to the Stage. 
3. Use alpha, brightness, and tint (in the Properties panel) to change an instance of a 

symbol without affecting the symbol as it is stored in the Library. 
4. Use the Free Transform tool, Transform panel, and Modify menu > Transform 

options to scale, skew, or rotate an instance without affecting the symbol in the 
Library. 

5. Recognize a keyframe and distinguish it from a regular frame. 
6. Position an object in a starting keyframe and in an ending keyframe. 
7. Apply a motion tween to cause an object to move. 
8. Test an animation. 
9. Add frames (F5) and keyframes (F6) to the Timeline. 
10. Remove frames and keyframes from the Timeline (Shift-F5). 
11. Lengthen or shorten a motion sequence in the Timeline. 
12. Change the starting or ending point of a motion sequence by dragging a keyframe. 
13. Add and name new layers in the Timeline. 
14. Rename a layer. 
15. Animate multiple objects in separate layers. 
16. Test your movie (this generates an .swf file). 
17. Insert ActionScript on a frame to make the movie stop looping (play only once). 
 
(end) 


